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Welcome
Fauna has three basic requirements for survival; food, water and shelter. Natural hollows play a crucial role 
in the survival of many animal species as they can contribute to all three basic requirements. However, the 
most important function of hollows is providing shelter.

Understanding the importance of hollows as shelter, how their availability has changed in the last 175 
years, impacts on native wildlife and what may be done to enhance hollow dependant fauna will all be 
considered in this resource.

A better understanding of their local environment and how it has been altered, will allow your students to 
make informed decisions about how they choose to live their lives. This, in turn, will influence the school’s 
approach to management of hollows and facilitate greater community understanding of this essential 
environmental resource.
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Background Information
Native vegetation communities, or types, vary significantly across SA due to local differences in soil 
type, climate, elevation and rainfall. Adelaide was settled by Europeans in 1836. Research has shown 
that before development and clearing, the Adelaide Plains supported 21 main vegetation types (or 
associations) ranging from open forests and woodlands to coastal dunes and salt marshes. 

You can view a colour map of these vegetation types and find out the original plant community that existed 
in your local area here.

Simply click to view the original pre-European vegetation map and then choose either the northern or 
southern map according to your site location and move the cursor over the map until the name of your 
particular suburb appears. Click to download a detailed Historical Plant List for that particular location.

What are natural hollows?
Natural hollows are cavities within living or dead timber, with an entrance/exit to the external environment.

Hollows typically form in living trees that are more than 80-120 years old. They are important features of 
forests and woodlands, but may also be found at lower densities in other habitat types. Hollows may occur 
in standing trees, as well as fallen trees; be they on the ground, buried (fully or partially) or submerged in 
water. While each type of hollow has an important role to play in its respective habitat and will attract its 
own specific wildlife, the focus for this resource will be standing trees and fallen timber on the ground.

Natural hollows range in size from small cracks just a few millimetres wide to large hollows which may be 
50cm or more wide and several metres deep. Hollows can occur in the trunk, vertical or horizontal limbs, or 
stumps and the entrances can be at any height. This variety provides habitat complexity and contributes to 
greater biodiversity.

The vast majority (~90%) of naturally occurring hollows, across the Australian landscape, form in eucalypt 
species. Other native trees also contribute to hollow habitats, including rainforest and mangrove species, 
however they are less common in school grounds.

A range of exotic trees (e.g. beeches, elms) has been planted in the Adelaide region of South Australia and 
many of these trees have softer wood and tend to develop deep hollows far more quickly than our native 
trees, so they are a valuable short-term resource. However, they are typically shorter-lived than eucalypts, 
so the hollows are also viable for a shorter period.

How do natural hollows form?
The majority of the animal species living in and on trees are invertebrates (animals without backbones), 
most of which we never even see. They may include adult and/or larval forms and some of the most 
important are termites, beetle larvae and moth larvae which feed primarily on dead timber (heartwood), 
creating “spaces” within the tree. Over time these spaces are enlarged and develop into viable hollows.

A hollow formed within a tree only becomes useful to hollow-reliant vertebrates once it is exposed to the 
outside world. This exposure of the “insect-created” internal hollow, requires some form of impact (for 
example fire, lightning strike, broken bough or human pruning) for it to be exposed. When the heartwood 
is exposed to air, it dries out and begins to shrink and crack. Insects and fungal spores which come into 
contact with these cracks may further break down the dead wood and expand the original crack, enabling 
access by spiders, centipedes, insects, micro-bats, small birds and other organisms which enlarge the 
entrance and hollow even more.

None of our native vertebrate fauna (parrots, possums, gliders and owls etc) are able to create their own 
hollows, although some may modify an existing hollow to better suit their needs. Fire may also influence 
the development of a new or existing hollow.

http://www.naturalresources.sa.gov.au/files/sharedassets/adelaide_and_mt_lofty_ranges/plants_and_animals/ubu_flash_maps/backyards4wildlife-vegetation-map.swf


Native fauna depend on hollows
In excess of 300 native vertebrate species use hollows in some form. Some species (e.g. Brushtail 
Possums and Adelaide Rosellas) are entirely dependant on hollows for some aspect of their life and are 
referred to as obligate hollow users. Other species, such as Pygmy Possums or Sacred Kingfishers, 
depending on their location, may use natural hollows but seek alternatives if hollows are not available. 
Approximately one third of Australia’s terrestrial (land) mammals (possums, gliders, phascogales, 
dunnarts, quolls etc) and two thirds of our micro-bat species use natural hollows.

Fifteen percent of our bird species are dependant on hollows for either roosting, nesting or food. This may 
appear to be a low number but, in comparison to North America or southern Africa, which exhibit the next 
greatest hollow dependency (10% and 9% repectively), it is obvious that hollows are incredibly important 
to Australian birds. In fact, it is thought that our parrots and kookaburras are amongst the oldest hollow 
nesting birds in the world.

Locally the number of reptile species which regularly use tree hollows is quite low, probably just 4-6 
species, but some reptiles will take advantage of low hollows, cracks and bark in standing timber, as well 
as fallen or partially buried logs on occasion.

None of the local native frogs use hollows to any real extent. However, other Australian tree frogs, in 
particular those from higher rainfall areas, extensively use hollows or take shelter under fallen bark or logs.

As mentioned, invertebrates far outnumber the vertebrate species which use hollows and are extremely 
importance to hollow development.

Assessing hollow habitats
Unfortunately, accurate information about the presence of hollows in the different habitat types across 
Adelaide pre-1836 is not available, but it can be inferred that there were significantly more than currently 
exist, and with greater variety. Assessing the quality of available hollow habitat that now exists in the study 
area involves measuring a number of perimeters:

•	 Number of large trees
•	 Number of hollow bearing trees
•	 Average number of hollows per hollow-bearing tree
•	 Circumference of tree (at 1m)
•	 Height of tree (estimate)
•	 Numbers of hollows (actual count and/or estimate for % of tree missed)
•	 Sizes of entrance holes (estimate)

•	 Small: <4 cm2

•	 Medium: 4-8 cm2

•	 Large: 8-12 cm2

•	 Very Large: >12 cm2

•	 Height of hollows 
•	 Orientation (e.g. North, east-south-east)
•	 Evidence of use
•	 Connectedness of the landscape.

Once this information is available, plans can be made to ensure that the current generation of hollow 
bearing trees is protected and the next generation is planned for. Additionally, as an interim measure, 
schools can augment the existing natural hollows with artificial hollows (nest boxes).



Activity 1: Identifying the Study Site/ 
Obtaining an Aerial Photo
N.B. if this activity has been undertaken for the Terrestrial Habitat Assessment module, please collect 
those results and go to Activity 2.

Download and install the Google Earth mapping tool at http://earth.google.com

1. Enter your suburb in the “Fly to” search engine

2. Zoom in on your study area until it fills the frame of the screen, rotate the image so that the boundaries 
are square with the frame.

3. File -> Save -> Save Image (Save two images – one close up of the study area and a map showing the 
land within a 1km radius).

4. The next step is to determine the size of your study area using one of the methods below:

If the shape of your site is roughly square or rectangular, you have two options:
a) Use Google Earth – go to Tools -> Ruler -> Line and change the unit of measurement to ‘metres’. Use 

this tool to obtain the dimensions of your study area.

b) Take accurate measurements on the ground with your students using a trundle wheel.



If the shape of your site has curved edges or cannot be measured by the above method, there is an 
easy way to determine its area:
This area function is only available in Google Earth v5.2.1.1547, which can be downloaded from 
www.filehippo.com/download_google_earth/8157/

1.	Use Google Earth and go to Add -> Polygon.

2.	Once the polygon window has popped up, click the ‘Measurements’ tab and change the ‘Area’ to 
‘Hectares’. 

3.	Then, click and release the left mouse button to add points to trace around the boundary of your site, 
eventually meeting back up with the point that you started.

4.	The polygon window will display the area of your site in hectares, as well as the perimeter distance.

5.	You might like to experiment with the Style and Colour of your shaded polygon.

You can save a copy of your shaded site by going to File -> Save -> Save Image.
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Worksheet 1: Determine the size of the study 
area in hectares
School:__________________________________________________________ Date:_____________

Class conducting the survey:___________________________________________________________

Site name:________________________________________________________ Site code:_________

What to do
If you have a square or rectangular study area and you used the Google Earth Ruler tool or measured the 
actual distance on the ground, you can determine the area by simply multiplying the length of two edges of 
your site and dividing the result by 10000. 

For example, the site below has one edge 355m long and the other 402m.

So 355m x 402m = 142710m2.

Divide 142710m2 by 10000 = 14.271ha (the area in hectares).

If you used the polygon method to determine the size of your area, Google Earth will have provided you 
with the measurement in hectares..

Size of your study area in hectares

402m

35
5m



Activity 2: Number of Large Trees
Summary
Duration: 45 minutes

Setting: In the classroom and outdoors (at study site)

Enables the students to appreciate which trees in the study site and greater landscape have significant 
habitat value.

Student Outcomes
This activity will enable students to:

•	 identify large trees in the landscape
•	 identify which of those large trees are the most important biological assets in the school
•	 appreciate benefits of large trees
•	 raise awareness of issues/risks associated with large trees
•	 recognise that trees are essential and risks need to be managed.

Background for Teachers
Materials
Worksheets

The activity
Walk around the study area and for each tree record if it is:

•	 local native (i.e. occurring naturally in this region), native (from Australia) or exotic (introduced from 
another country)

•	 dead or alive
•	 hollow bearing
•	 a large tree*.

*To determine if a tree is classified as a ‘large tree’, measure the circumference of the tree at chest height 
(one mtere above the ground) using the tape measure. If it is greater than the benchmark level of 200cm, it 
is classified as a large tree.

Next, calculate the number of large trees per hectare in the study area:

i.e.: Number of large trees per hectare = 	 number of large trees in the study area
 							         number of hectares in the study area

Then calculate the number of hollow bearing trees in the study area and the average number of hollows 
per hollow bearing tree.

As a class discuss potential actions that your school can do to protect and improve the number of large 
trees in the study area.

Extension Activities
Calculate/record:

•	 Height of tree (see www.burkesbackyard.com.au/factsheets/Others/Estimating-Height-of-Trees/3085 
for an example of how to estimate the height of a tree. Smartphone apps for measuring height are 
also available.)

•	 Sizes of entrance holes (estimate)



•	 Small: <4 cm2

•	 Medium: 4-8 cm2

•	 Large: 8-12 cm2

•	 Very Large: >12 cm2

•	 Height of hollows 
•	 Orientation of hollows (e.g. North, east-south-east)

Research what is shelter/what are hollows? What is flora? What is fauna?

Art/Design: Create your own hollows using boxes, tubes, cannisters etc. Illustrate creatures found in 
hollows.

Maths: calculate the height, diameter and circumference of trees on the study site. Count the number of 
hollows present. What proportion of the trees have hollows?

What are the ecological and economic benefits of retaining large trees vs removing them? 

Debate: A significant hollow/habitat tree is a safety risk - retain or remove?

Investigate: Are the natural hollows in your study area being used by local wildlife? What creatures are 
using them? What is the evidence to support these answers? Are the creatures using the hollows native or 
exotic, beneficial or harmful?
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Worksheet 2a: Number of Large Trees
School:__________________________________________________________ Date:_____________

Class conducting the survey:_________________________________________ Start time:_________

Site name:________________________________________________________ Site code:_________

What to do:
•	 Walk around the study area and record in the table each tree that you find (dead trees may also be 

included).
•	 Record if the tree is native (from Australia) or exotic (introduced from another country), alive or dead.
•	 Record the circumference of each tree at chest height (1m above ground).
•	 Record the number of hollows you can see in the tree.
•	 Record if the tree is a large tree (i.e. has a circumference at chest height >200 cm)

Tree Number Native / Exotic  
(N/E) 

Dead / Alive

(D/A)

Circumference at 
1m (cm)

Number of 
Hollows 

Large Tree? 
(Y/N)

e.g. Tree 1 N A 200cm 3 Y

How many large trees are found in the study area? _________

How many native large trees are found in the study area? _______

Number of large native trees/ha = 	 number of large native trees in study area
 						             number of hectares in study area

							       = _______ ÷ __________ = ________
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Worksheet 2b: Number of hollow-bearing 
trees
School:__________________________________________________________ Date:_____________

Class conducting the survey:_________________________________________ Start time:_________

Site name:________________________________________________________ Site code:_________

What to do?
For this exercise, we will be focusing on the large trees identified in the worksheet 2a, as these are the 
ones most likely to be hollow bearing.

Step 1: How many of the large trees identified in worksheet 2 are hollow-bearing? ______.

Step 2: How many large hollow-bearing trees are present per hectare?

Calculation: Number of hollow bearing trees/hectare (ha); equals the number of hollow bearing trees 
across the study site, divided by the number of hectares in the study site:

number of hollow bearing trees ________ ÷ number of hectares in study site ________ = ________

Step 3: What percentage of the trees are hollow-bearing?

Calculation: Number of hollow bearing trees, divided by total number of trees:

number of hollow bearing trees ________ ÷ total number of trees ________ = ________
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Worksheet 2c: Number of hollows per tree
School:__________________________________________________________ Date:_____________

Class conducting the survey:_________________________________________ Start time:_________

Site name:________________________________________________________ Site code:_________

What to do
Once again, for this exercise we will be focusing on the hollow bearing trees identified in the worksheet 2a.

Step 1: For each hollow bearing tree, count the number of hollows visible from the ground:

Step 2: How many hollows in total were found across the study site? _________

Step 3: How many hollows were found on average per hollow-bearing trees at the study site?

Calculation: Average number of hollows per hollow bearing tree; equals the total number of hollows across 
the study site (step 1), divided by the number of hollow bearing trees across the study site (step 1 from 
worksheet 2b):

total number of hollows ________ ÷  number of hollow bearing trees ________  =  ________ 



Activity 3: Healthy Trees - Healthy 
Environment (Understorey Vegetation)
N.B. if this activity has been undertaken for the Terrestrial Habitat Assessment module, please collect 
those results and go to Activity 4.

Summary
There have been significant changes to the landscape since European settlement in 1836. Huge tracks 
of land have been cleared or modified, which has put pressure on many of the remaining trees and 
associated wildlife. The changes to the landscape have usually simplified the available habitat, leading 
to fewer native species and, in many cases, an increase in exotic/introduced species of both plants and 
animals (e.g. willows, blackberries, sparrows, foxes).

Connectivity of habitat across the landscape is incredibly important to enable fauna species to move 
through the landscape. A variety of habitat layers (grasses, shrubs, trees etc) is also important to allow 
vertical connectivity in the landscape.

Duration: 45 - 60 minutes

Setting: In the classroom and outdoors (at study site)

This activity enables the students to appreciate the importance of the health and connectedness of trees in 
the study site and greater landscape, and their significant habitat value.

Student Outcomes
This activity will enable students to:

•	 understand the importance of a continuous tree canopy, to facilitate fauna movement across the 
landscape

•	 understand the importance of native understory plants to the health of the large trees and increasing 
biodiversity

•	 identify how native understory planting may enhance the school grounds for the benefit of wildlife and 
people

•	 conduct a survey to determine what species already exist on the school grounds/study site.

Background for Teachers
Trees are the largest living organisms in our landscape. Many creatures live in them, on them or rely on 
resources they provide. From a biodiversity perspective, however, trees represent just a small fraction of a 
region’s biodiversity. Indeed the majority of the biodiversity that occurs in an area will be found in the metre 
above and below ground level.

Flowering plants, fungi, mosses, bacteria, insects, spiders, worms, birds and mammals are just some of 
the organisms that make up the local ecosystem. Typically the more complex the environment, the more 
resistant it is to change or insult. Diversity in understory plants helps to support tree health,

Materials
Student Worksheet 3: Understorey Vegetation, pen/pencil.

The Activity
Estimate the percentage cover of native understorey in the study area and record this in the Student 
Worksheet 3: Understorey Vegetation. Also record the types of vegetation present in the study area.

As a class, discuss potential actions that your school can do to protect and improve understorey in your 
study area.



Extension Activities
Mapping activity: Can a possum get from one side of the school to the other entirely in the tree/shrub 
canopy without putting a foot on the ground? Map the best route!

Survey birds at your site. What are the most common types of birds found? Where in the site are they most 
commonly found? Why are they found where they are found? Are the areas simple or more complex?

Does the school/study site have any native bushland/creeks close by? How large is this area? How far 
away from the school grounds is it? Do birds move between the bushland area and the school? If so, how 
do they tend to do this?

What could you add to your school grounds from what you have discovered to enhance the environment 
for native wildlife: trees, shrubs, ground cover, water, rocks, fallen timber, etc?

Narrative: consider building a wildlife garden - write about the local native you would most like to have 
in the garden and why? How would non-flying animal species move through this garden safely? Identify 
some of the threats some of these species may face.

Debate: Engaging with wildlife improves our health and well-being.
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Worksheet 3: Understorey Vegetation
School:__________________________________________________________ Date:_____________

Class conducting the survey:_________________________________________ Start time:_________

Site name:________________________________________________________ Site code:_________

What to do
Step 1: Walk around the study area and estimate the percentage cover of native understorey vegetation. 

Native understory cover = _____%

Step 2: Tick below the types of native vegetation you find in the study area:

Native Vegetation Present 
(ü / û)

Tree > 5m
Shrub (1-5m)
Small Shrub < 1m
Large Herb > 0.5m
Small Herb < 0.5m
Fern
Moss / Lichen
Scrambler / Climber
Tall grass (or grass-like) > 1m
Small Grass (or grass-like) < 0.5m
Other _________



Activity 4: Augmenting Habitat - Wildlife 
need hollows
Summary
Shelter is one of the three essential requirements for an animal’s survival.

Hollows are important for a number of reasons; shelter from the elements, sources of food and water, and 
protection from predators. Natural hollows in live trees may also be of assistance with the management of 
temperature and humidity.

Different fauna species may be vulnerable, or require shelter, at different times or life stages. Those stages 
may either reflect the life-cycle of the animal, period of activity (e.g. diurnal, nocturnal or crepuscular), the 
location or the season.

Duration: 45 - 90mins

Setting: In the classroom and outdoors (at study site)

This research activity enables the students to appreciate the importance of hollows within the landscape, 
and how their presence contributes to habitat value. It will also enable the students to appreciate that a 
hollow is far more than “just a hole” in a tree, with many species, large or small, using these resources.

Student Outcomes
This activity will enable students to:

•	 understand the importance of hollows to native fauna

•	 understand that hollows come in all shapes and sizes

•	 understand that animals can have quite specific “hollow” requirements

•	 recognise that natural hollows need to be retained wherever possible

•	 appreciate that where natural hollows have been removed or occur in limited numbers, artificial 
hollows (nest boxes or hollow creation) may be used to support native species

•	 research the local native species that require hollows

•	 put together a site-appropriate artificial hollow/nest box kit, either bought or supplied by local 
woodworkers/Men’s sheds (Practical/manual Exercise under supervision).

Background for Teachers
Many vertebrate species, particularly birds and mammals, need extensive care when young, sometimes 
for extended periods. Nocturnal species (e.g. Micro-bats, possums) may use hollows to gain protection 
from daytime predators. Other species, such as Ringtail Possums, may seek the shelter of hollows only 
during the wet and windy months, preferring to construct their own dreys for the rest of the year. Some 
species use a hollow for 1-2 months a year, others six months and some all year round.

Living trees provide a stable environment in which to shelter. Trees regulate their own temperature and 
animals sheltering within them may take advantage of this. On a hot day, temperatures within a living tree’s 
hollows may be more than 10°C cooler than the outside air temperature. Similarly, temperature may be 
10°C warmer inside a living tree hollow on a cold day. Relative humidity may also assist in the survival of 
many species.

Approximately one third (31%) of terrestrial mammals, two thirds (66%) of micro-bats and 15% of birds 
in Australia are reliant on hollows. Additionally, many reptiles, frogs and invertebrate species also take 



advantage of available hollows.

Articifial hollows/nest boxes are not true replacements for hollows. They do, however, provide important 
habitat when natural hollows are limited or absent.

Materials
Workbook - Lower primary & upper primary.

Resource list for Teachers: Hollow dependant species; nest box plan, websites.

Nesting box kits and associated instructional information (as required)

The Activity
What benefits do you get from your house at home? Which of these are also likely to benefit wildlife 
species? Are there any additional benefits wildlife species may receive from hollows?

Research hole size. Why is this important? What role does the size of the entrance play in selection of a 
suitable hollow? Compare sizes: using a range of hollow sizes, match different creatures to the type of 
holes they use.

Identify hollow dependant species found in the local area. Assess which species are most likely to be 
attracted to artificial hollows.

As a class, discuss potential actions that your school can do to protect and improve hollow habitats in your 
study area. Would installing nest boxes make a positive impact?

Extension Activities
Write a letter to a local landcare group/NRC/museum/bird or mammal society to have help in identifying 
which animal groups &/or species:

•	 use hollows in your local area
•	 would be the best species to target in trying to enhance habitat at the school/study site.

Collate the replies for the letters and identify preferred target groups/species - to SCR (Student Council 
Representatives), conservation club or similar for discussion across school.

Design the ultimate nest box for a particular animal species. What considerations need to be made for that 
animal? Where would it be installed?
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Activity 5: Augmenting Habitat - 
Placement of nest boxes
Summary
Artificial hollows can be a valuable resource when natural hollows are lacking. Unfortunately, nest boxes 
lack a number of inherent benefits found in naturally occurring hollows. For this reason, the placement of 
nest boxes is quite important. Lacking the temperature regulation benefits of natural hollows, nest boxes 
need the physical protections of the local environment (e.g. canopy cover, thick trunk) to minimise the 
possibility of them over-heating or becoming too cold.

Duration: 45 minutes & 60min extra-curricular

Setting: In the classroom and outdoors (at study site)

This research activity enables the students who have now come to appreciate the importance of hollows 
as part of the Australian landscape, to assess how and when it would be best to deploy the nest boxes.

Student Outcomes
This activity will enable students to:

•	 gain practical written experience requesting assistance from external organisations to assist with the 
installation process

•	 understand that different species have different requirements when it comes to hollow placement

•	 appreciate some of the complexities in locating an nest box when consideration is given to the sun, 
prevailing rain, tree cover, tree connectivity and potential predators

•	 appreciate that there are risks associated with working at heights, so adults with experience have been 
called in to assist with the installation (also allows for community engagement and extra-curricular 
learning opportunities)

•	 take satisfaction in, and be congratulated for, completing a collaborative task.

Background for Teachers
When locating nest boxes many different factors need to be considered (refer to fauNature ‘Recommended 
Orientations for installing a Wildlife Box/Hollow’). Birds and possums prefer to have their box in a cool dry 
location, while bats often prefer their box where it will receive the maximum amount of afternoon sun. Birds 
prefer a relatively open aspect, whereas possums typically opt for a more sheltered location when it is 
available.

Few fauna species nest close to the ground, unless it is in a safe location; they generally prefer hollows 
higher up in a tree. Most of the common hollow dependant species would use a nest box that is located 4m 
off the ground, however 6-8m would be preferable for most parrot species and kookaburras. 

The box entrance needs to face away from the wettest winds, so avoid the south-west to west. Ideally, the 
box will be placed on a vertical or slightly forward angled trunk, to reduce rainwater entry. Also, if possible, 
the box should be located away from a tree fork, to deter cats or foxes.

A mature native tree with a trunk diameter of at least 25cm (preferably 35cm or greater), is required to 
support even the smaller boxes. Avoid fast growing forestry eucalypts (e.g. Sydney Blue Gum, River Red 
Gum, Spotted Gum) as these species grow incredibly quickly and may compromise the box’s attachment 
system. 





Materials
Compass

Original Map, with large trees identified.

Installation instructions: either from the supplier of the nest box kit or recommendations from the “source” of 
the kit.

Range of household items and some stuffed animals or plastic invertebrates.

The Activity
Location is very important in a nest box!

What parameters need to be considered when installing nest boxes? How are issues, like is it safe, secure, 
weather proof, good view, not too hot or too cold and easy to get to, important for each species? Are the 
requirements the same for all species or are there differences between animals? 

Using the support materials provided, research the most appropriate location(s) at your site to install nest 
boxes. Consider noise, orientation, type of nest box/target species, tree species etc.

Extension Activities
Use a compass to learn about north, south, east and west. Ask the students to determine a given direction, 
for a particular box.

Write to local council, CFS/MFS/SES, school community to assist the school with the installation of the 
artificial hollows/nesting boxes.

When will the wildlife use the nest box? When is it best to install the nest box? Is there a preferred time of 
year or can it be done at any time?

Make signs explaining the different types of boxes and what animals will hopefully be attracted. Signs can 
also be used for exclusion zones.

Maths - map and graph the various parameters associated with the installation: box type, box number, 
location, orientation (of entrance), height etc (see attached).

Debate: Brushtail Possum: urban terrorist or threatened species?



Activity 6: Augmenting Habitat - 
Monitoring nest boxes
Summary
To get the most out of a nest box for wildlife and the educational opportunities, monitoring is essential. 
Monitoring will reveal what species use the nest box and how valuable an asset it is. Comparing survey 
results taken before, during and after habitat enhancement efforts have been undertaken will enable the 
school to quantify the improvements that have taken place. Monitoring can be used not only to assess the 
progress that has been made, but also to assist in tailoring future habitat improvements to either capitalise 
on strengths or consolidate and address under-performing areas.

Monitoring can be carried out from a relatively basic through to quite an advanced level, allowing all 
members of the school community to be involved. Additional opportunities to integrate the findings into 
other aspects of the curriculum such as maths, english, society etc are all possible from the monitoring 
information gained. 

Duration: 45 minutes to 90min split over 2-3 months

Setting: In the classroom and outdoors (at study site)

This activity enables the students to observe, both actively and casually, the biodiversity benefits achieved 
as a consequence of their nest box program. 

Student Outcomes
This activity will enable students to:

•	 gain an appreciation of how seasonality affects native fauna

•	 understand different life cycles – these are integral to understanding the natural world and monitoring 
enables the students to observe some of these first hand

•	 record the chronology of events and see how nature changes over time

•	 appreciate that there are many ways to investigate and monitor the successes and failures of a program

•	 recognise signs of animal usage in and around the nest box.

Background for Teachers
For many students, life is a combination of structured and unstructured activities. While these activities 
may take place on a daily or weekly basis, the importance of routine may not be appreciated by the 
students. In this activity, students will be able to monitor one or more wildlife boxes to determine a range of 
parameters associated with the installation:

•	 is it being investigated by wildlife? If so, what types/species, what are the signs of activity?

•	 are the boxes inhabited? If so, by what types/species?

•	 is the box being used for shelter or breeding? Was the breeding event successful?

•	 have any unwanted species been attracted to the box? If so, what are they?

•	 were the animals present throughout the day or more often seen at specific times?

As can be seen, many different questions can be asked to build up a picture of the activities in and 
around a given box or the boxes right across the school. Different groups of students can also be asked 
to observe the box(es) casually vs in a scheduled manner, thereby highlighting the potential differences in 
observational techniques. Overlaid on this might be weekly, daily or even hourly observations to determine 



the most useful frequency for observation, while requiring the least amount of time. The data generated 
may also be included into the school’s SEMP/environmental planning.

Materials
Data record sheet.

Reference book: Tracks, Scats and Trails.

The Activity
Initial observations from the ground

•	 allow approximately one minute for each nest box in the survey area (e.g. 12 boxes = 12 minutes)
•	 note any bird species seen in the area in this time, particularly if they appear interested in any of the 

boxes
•	 quietly walk around the survey site and check each box for damage and/or obvious signs of use.

More detailed external observations
Adults: use a ladder to carefully acces the nest box. Nest box cameras are available for loan from the NRM 
Education resource library and are a much safer alternative.

•	 check for evidence of use:
•	 claw or chew marks on the box or entrance
•	 fur or feathers trapped at the entrance to the box
•	 discolouration around the entrance of the box

•	 photograph inside the box, via the entrance hole if possible
•	 assess any wildlife that may be present (if investigating large bird or possum boxes, large animals 

may be present, which can bite and/or scratch, so take care!)
•	 If wildlife is currently using the box, limit the investigation to photographs in order to minimise the 

disturbance to the animals.
•	 If no animals are currently using the box, continue with an internal examination of the box.

Internal Examination
•	 has the box been used? 
•	 assess whether any fur or feathers are present in the box. You may like to take samples in order to 

identify species using the box.
•	 are there internal claw or chew marks?
•	 has bedding material been moved/used?
•	 is there any faecal matter present or are there any parasites?

Record any findings

If the nest box is in need of major repair or for annual maintenance, disconnect it fom the tree and 
undertake activity 7.

Extension Activities
Life cycles: look at the seasons/patterns of wildlife box use, with different species being investigated. When 
do most birds tend to nest? Do any birds use boxes outside this period, for either roosting or nesting? Are 
possums seasonal users of the boxes or do they use them year round? If possums have been targeted, 
have the students seen evidence of the possums presence, given they are nocturnal creatures?



Photograph or draw animal species using the boxes.

Science - what is a hypothesis? Have the students develop their own hypotheses (individually or in groups) 
around box usage. Have the students test their hypotheses and report. Hypotheses could be linked to life 
cycles, species usage or area of the school. Of the species recorded, were they all expected? Were they 
native species or were they exotic species? Were they pest species? If so, were they dealt with? In what 
way?

Maths - graph activity seen at various boxes. Record signs (scratches, chewing etc) as evidence of activity, 
species seen in vicinity, species using the box(es). This recording can be undertaken in a systematic or ad 
hoc manner with different groups of students, to identify if one observational method is superior to another. 
Graph and explain findings.

English - write a report on an animals found using the nest box or the one thing that the student/group 
found most interesting. This could be presented to the class orally.

Technology: using either digital cameras or videos, assess internal or external activity associated with the 
box. Make a poster or digital presentation using the material collected and display it in the school. 

Technology: develop short documentaries highlighting different aspects of engaging with fauna around the 
school from life history, reproduction, shelter or general nature themes.
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Activity 7: Augmenting Habitat - 
Maintaining nest boxes
Summary
Products, like living organisms, have life cycles. To maximise the “life” of a product, it needs to be cared 
for, ideally following the manufacturer’s instructions. Over time, wooden wildlife boxes will deteriorate; sun, 
wind, rain and the animals themselves can all take a toll on the boxes. The sun and wind can dry out and 
crack the wood; boxes can start to rot when wet. In addition, possums, parrots and other creatures can 
modify a box if it is not to their liking. 

Regular maintenance (annual) on the box, including checking the attachment system, treating the exterior 
of the box, clearing out last year’s nesting material and replacing it with fresh wood-chip etc, all extend the 
life of the box. 

Occasionally emergency measures are required where a large animal has tried to invade a box which is 
too small for it, causing damage to the box in the process OR the box has been invaded by a feral species 
(e.g. European starlings or honey bees). Under such circumstances, prompt action will minimise damage 
and return the box to service as quickly as possible.

A sound, on-going maintenance regime also enables the quality of the boxes to be monitored. This 
way, potential safety issues can be spotted well before they are a concern to either people or the box’s 
inhabitants. Major work can be factored in well in advance of breeding season, when the box will be in 
greatest demand. Also, replacement can be planned allowing for season, species, budgets for repairs or 
the purchase of new materials.

Student Outcomes
This activity will enable students to:

•	 gain an appreciation of how maintaining and caring for assets/possessions will extend or maximise their 
useful life

•	 be active in refurbishing (not removal or reinstallation, this must be done by adults) of the boxes

•	 understand that life cycles apply not only to the natural world but also the goods we use every day - the 
care requirements of cars, lego, ipods or wildlife boxes will differ but, in all cases, to get the most out of 
the item it needs to be looked after

•	 recognise the successes/failures of the program, in relation to target species usage, non-target species 
or pests

•	 be able to see first hand evidence of wildlife use (scratches, chewing, feathers, fur, droppings, parasites, 
etc)

•	 appreciate that the wildlife boxes or local hollows are just part of the broader local environment - 
this environment, just like the boxes, needs to be monitored and maintained if we are to receive the 
environmental services humans rely on for their very survival.

Background for Teachers
This particular activity is both a very practical one regarding the ongoing nature of the hollows/wildlife 
box project and in relation to life learning experiences. The boxes need to be cleaned out, new bedding 
material added etc in preparation for the next breeding season. 

This process can be related to similar activities around the school or at home that the students are familiar 
with. Painting of houses, weekly cleaning or washing, big ‘spring’ cleans once a term or once a year can all 
be related back to this activity. The life skills and situational learning can be very strong with maintenance 



issues as many household items the students use on a regular basis need care and attention if they are 
going to continue to perform properly (bikes, skateboards, scooters, footballs, netballs, cricket bats etc). 
Maintenance may be as simple as pumping up a netball at the start of the game or as complex as stripping 
down a bike that has been badly neglected.

The maintenance of the boxes may apply to the older students more than the younger ones.

Materials
Instructional sheets on how to maintain a nesting box, including all of the aspects to consider for regular 
or emergency maintenance. For more information on maintaining nest boxes, see http://faunature.com.au/
wildlife-education/nesting-boxes/maintaininganestingbox.html

The Activity
Undertake repairs to the nest boxes according to the recommended or manufacturer’s instructions.

Extension Activities
Science - Life cycles: if parasites (e.g. maggots, pupal cases) or other invertebrates are found in the 
boxes, how they might have got there? What do they use the box for? 

English - write a letter to the school community (parents & friends), CFS, MFS, SES or council to get 
assistance with the removal for maintenance and re installation of the wildlife boxes.

Technology: investigate the life cycle (design, manufacturer, usage, maintenance, replacement or disposal) 
of a product (eg computer, ipod, bicycle etc).

Science - Identify uptake by target species, non-target species and pest species.  Many eyes make for 
a quick response - all the school community has the responsibility for keeping an eye on the boxes; the 
sooner pest species are reported (if they take an interest in a box), the sooner action can be taken to 
address the situation.

Maths: Graph and chart activity for each box and the school environment as a whole. Identify both positive 
and negative impacts, which can which can be used to consider how to improve the program.

Debate: European honey bees - economic imperative or an environmental disaster? 


